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Introduction

Congratulations! You’re on your way to 
understanding your financials like never 
before. The purpose of the NARPM® 

Accounting Standards Chart of Accounts is to 
provide a basis for standardizing, analyzing, 
and understanding financial performance in the 
residential property management industry.

In addition, this standardized Chart of Accounts 
(and the metrics derived from it as detailed in the 
NARPM® Accounting Standards Financial Metrics 
Guide) will provide a common language for 
comparing financial performance among property 
management companies. We believe this will 
result in many rich and meaningful conversations 
among peers and will allow the discovery of many 
new insights and fresh ideas for action.

NARPM® Chart of Accounts 
Overview
The NARPM® Chart of Accounts is designed for 
practical accounting and reporting that reflects the 
reality of your property management business. 
Because of this focus, it does not always align 
with the generally accepted accounting principles 
(GAAP) chart of accounts, nor is it intended to. You 
need reports that speak to your specific situation, 
not reports that follow a generic template.

As you start to implement the NARPM® Chart 
of Accounts, you may notice several accounts that 
don’t fit your specific situation. Feel free to pick 
and choose the accounts that apply to your 
company. In fact, you need to pick and choose. 
The COA zeroes in on accounts that make sense 
for property management, but it also makes 
accommodations for other ancillary divisions, 
such as maintenance and brokerage. If certain 

accounts don’t apply to you, don’t try to use 
them. Just select the relevant accounts for your 
business and start rolling.

Custom NARPM® Chart of Accounts 
Generator
A full, uncustomized version of the NARPM® Chart 
of Accounts is included at the end of this document. 
However, to generate a chart of accounts specific 
to your business needs, check out our custom 
NARPM® Chart of Accounts generator available at 
www.PMProfitCoach.com/coa.

How to Use the Chart of 
Accounts
The chart of accounts has been structured to 
require consistent usage across many companies, 
while at the same time allowing for customization to 
accommodate the unique needs of each business. 
To accomplish this, it is organized in a four-digit 
numbering system, containing a defined set of 
four-digit codes. While this set of four-digit codes 
is to be left unaltered, there are several specific 
options for customizing the chart of accounts. So 
here are the dos and don’ts.

General Rule: DO NOT Add to Or Modify 
the COA Structure
No additional four-digit codes, no altering the 
numbering system. For example, even though 
there is no account 4127 defined in the structure, 
you are not free to use that four-digit code for 
another account. The COA is to remain completely 
intact. That being said, you do have options for 
customization.

http://www.pmprofitcoach.com/coa
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How to Customize the Income Statement
DO add subaccounts to any existing income 
statement account. If you need further detail in 
any account, you have the option to add up to 99 
subaccounts using a two-digit decimal extension. 
For example, under account 4124, Other Owner 
Paid Fees, you may add accounts 4124.01 through 
4124.99 to track the breakout of specific owner-
paid fees.

Don’t see a logical place to book a 
transaction? The following example will illustrate 
how to customize the chart of accounts by adding 
a subaccount to allow for more detailed tracking 
of three specific transactions: a car detailing 
expense, a vehicle recycling expense, and a 
parking lot repair expense. Here we go!

1.	 Identify the most logical parent category for 
your new decimal subaccount. The parent 
categories in the COA are the four-digit codes 
ending in -00 (e.g. 6100—Facilities). They can 
be found in the “Parent” column in the table 
at the end of this document. In this case, 
the 6100—Facilities category is the obvious 
choice.

2.	 Review the child categories to see if your new 
code could logically fit in any of these. The 
child categories are the four-digit codes ending 
in -0 (e.g. 6110—Auto). They can be found in 
the “Child” column in the table at the end of 
this document. In the case of the car detailing 
expense, the 6110—Auto child category is the 
obvious choice.

a.	 If you find a logical child category match 
(as we have for the car detailing expense), 
review the accounts under this child 
category (if applicable) to see if your 
new code could fit in one of these (e.g. 
6111—Auto Lease; 6112—Auto Repairs & 
Maintenance). These accounts are called 
“Sub-Child” accounts and can be found in 

the “Sub-Child” column in the table at the 
end of this document.

i.	 If you find a logical sub-child account 
match:

1.	 One possibility is to book your 
transaction directly to this sub-child 
account. For example, you may 
want to book your car detailing 
expense directly to 6112—Auto 
Repairs & Maintenance. (Do car 
detailing expenses really need to 
be tracked separately?)

2.	 If you do need more specific 
tracking, add a two-digit decimal 
extension to the existing sub-child 
account code to create a new 
decimal subaccount (e.g. 6112.01—
Car Detailing). Congratulations! 
Now you have your very own car 
detailing expense account for 
your car detailing expense!

ii.	 If you don’t find a logical sub-child 
account match:

1.	 Look for the sub-child “Other” 
account within the child category 
section. Sub-child  “Other” accounts 
always end in -9 (e.g. 6119—Auto - 
Other). These will be found in the 
“sub-child” column of the chart of 
accounts.

2.	 Consider booking your transaction 
directly to this “Other” account in 
the child category. For example, 
you may want to book your vehicle 
recycling expense directly to 
6119—Auto - Other. (Do vehicle 
recycling  expenses really need to 
be tracked separately?)

3.	 If you do need more specific 
tracking, add a two-digit decimal 
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extension to the “Other” account to 
create a new decimal subaccount 
(e.g. 6119.01—Vehicle Recycling 
Expense). Congratulations! Now 
you have your very own vehicle 
recycling expense account for 
your vehicle recycling expense!

b.	 If you don’t find a logical child category 
match, look for the “Other” account at the 
bottom of the parent section. Child “Other” 
accounts always end in -99 (e.g. 6199—
Facilities - Other). These will be found in 
the “child” column of the chart of accounts.

i.	 One possibility is to book your 
transaction directly to this Other 
account. For example, you may want 
to book your parking lot repair expense 
directly to 6199—Facilities - Other. (Do 
parking lot repair expenses really need 
to be tracked separately?)

ii.	 If you do need more specific tracking, 
add a two-digit decimal extension to the 
“Other” account to create your decimal 
subaccount (e.g. 6199.01—Parking 
Lot Repairs). Congratulations! Now 
you have your very own parking lot 
repairs expense account for your 
parking lot repair expense!

How to Customize the Balance Sheet
DO add new four-digit child account codes 
for certain balance sheet child categories, but 
only for the child account categories specified 
below. The balance sheet COA is designed to be 
very flexible. You may have multiple accounts that 
would fit in one of the child categories below, so the 
COA gives you the option to add multiple account 
codes under each category. For cleaner reports, 
we recommend that you add account codes in 
increments of 10 (e.g. 1110, 1120, 1130) rather 

than increments of 1 (e.g. 1101, 1102, 1103).

•	 The Cash Account child category starts 
with 1110. Add checking accounts and other 
operating bank accounts from 1110-1190 
(allows for 9 options).

•	 The Loan Receivable child category starts 
with 1510. Add specific accounts from 1510-
1590 (allows for 9 options).

•	 The Credit Card child category starts with 
2210. Add specific credit card accounts from 
2210-2290 (allows for 9 options).

•	 The Line of Credit child category starts with 
2310. Add specific credit card accounts from 
2310-2390 (allows for 9 options).

•	 The Short-Term Loan child category starts 
with 2410. Add specific accounts from 2410-
2490 (allows for 9 options).

•	 The Note Payables child category starts with 
2610. Add specific accounts from 2610-2690 
(allows for 9 options).

DO add subaccounts to any existing balance 
sheet account. If you need further detail in any 
account, you have the option to add up to 99 
subaccounts using a two-digit decimal extension. 
For example, under account 1740, Computers & 
Software, you can add accounts 1740.01 through 
1740.99 to track the breakout of specific computer 
or software purchases.

Don’t see a logical place to book a transaction? 
The procedure for adding decimal subaccounts 
to the balance sheet is identical to the procedure 
for adding decimal subaccounts to the income 
statement outlined above (see the How to 
Customize the Income Statement section).
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Conversion Overview
There are two options for implementing the 
NARPM® Accounting Standards COA into your 
financial software. The option you choose depends 
on what level of historical detail and comparison is 
valuable to you.

Option 1: 
COA Merge without Reclassification
With Option 1, you’ll completely switch over to the 
NARPM® COA at a point in time and you’ll merge 
your historical COA into the NARPM® COA.

Implementing Option 1 is a three-step process. 
First, import the new COA accounts from our 
prepared CSV file. Second, take a month or two 
to operate with the new COA accounts and get 
acclimated. Think of it as a test run to be sure 
this system will work for you. Third, once you’re 
comfortable with the new flow of data, merge or 
subordinate all old accounts to the corresponding 
NARPM® accounts. Once this is complete, you’ll 
be ready to start fully operating and reporting with 
the new NARPM®  COA.

Specific implementation instructions are 
provided for QuickBooks Online (page 8) and 
QuickBooks Desktop (page 13).

Option 2: 
COA Merge with Reclassification
With Option 2, you’ll completely switch over to 
the NARPM® COA from the beginning of relevant 

history (we suggest at least two years). You’ll adjust 
the historical COA (as above) and you’ll reclassify 
historical transactions into the corresponding 
NARPM® categories. In other words, if, for example, 
you used to book your new owner advertising 
and your vacancy advertising expenses to the 
same “Advertising” account, you will separate 
these two types of transactions historically (again, 
going back at least two years) into the separate 
accounts provided in the NARPM® COA. Option 2 
is the most labor-intensive but translates into 
the most value, giving you the ability to make 
accurate historical comparisons and watch 
trends over time.

Implementing Option 2 is a four-step process. 
First, import the new COA accounts from our 
prepared CSV file. Second, take a month or two 
to operate with the new COA accounts and get 
acclimated. Think of it as a test run to be sure 
this system will work for you. Third, once you’re 
comfortable with the new flow of data, merge or 
subordinate all old accounts to the corresponding 
NARPM® accounts. Fourth, break out historical 
transactions that were originally coded to the same 
account but belong in different NARPM® accounts. 
Once this is complete, you’ll be ready to start fully 
operating and reporting with the new NARPM® 
COA.

Specific implementation instructions are 
provided for QuickBooks Online (page 10) and 
QuickBooks Desktop (page 16).

http://www.pmprofitcoach.com/COA
http://www.pmprofitcoach.com/COA
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QuickBooks Online Instructions

QuickBooks Online Instructions: 
Option 1

Turn On Account Numbering (If Needed)
•	 In QuickBooks Online, navigate to the gear 

icon > Account and Settings > Advanced.

•	 Under “Chart of accounts” (third section on the 
list), check that “Enable account numbers” is 
set to “On.” 

◦◦ If “Enable account numbers” is set to “Off”: 
▪▪ Click the pencil icon on the right side 
of the page across from “Chart of 
accounts”.

▪▪ Check the box for “Enable account 
numbers”.

▪▪ Check the resulting box for “Show 
account numbers”.

▪▪ Click “Save” and close out of the 
Account and Settings view.

Import All New Accounts
•	 Download the NARPM® COA CSV file from 

our custom chart of accounts generator here: 
www.PMProfitCoach.com/coa. This file is 
preformatted for import with the following fields:

◦◦ Account Number (e.g. 4100)
◦◦ Account Name (e.g. Residential PM 
Income)

◦◦ Type (e.g. Income)
◦◦ Detail Type (e.g. Service/Fee Income)

•	 Select the gear icon and click “Import Data” in 
the Tools column.  

•	 Select “Chart of Accounts”.

•	 Browse for the CSV file and select it. Click “Next”.

•	 Map the columns (use the column names 
above). Click “Next”.

•	 Review and click “Import”.

•	 If there are import errors, QBO will display only 
the lines with errors and will highlight the fields 
causing trouble in red.

◦◦ Account Number: There should be no 
Account Number issues in importing this 
file. 

◦◦ Account Name: This indicates that an 
account already exists with that name. 
Typical accounts caught here: Accounts 
Receivable, Retained Earnings, Fixed 
Assets, Interest Income, Interest Expense, 
Opening Balance Equity, Amortization.  
These accounts will not import.

▪▪ For each duplicate account, navigate 
to QBO’s Chart of Accounts, locate 
the account, and edit it to match the 
number, type, and detail type found in 
the imported COA. 

◦◦ Type/Detail Type: These will be red if they 
don’t exactly match QBO’s categories. We 
worked to eliminate all Type/Detail Type 
errors, but please let us know if you have 
this error and which account the error 
appeared on. To fix, simply choose the 
closest match from the dropdown menu.

▪▪ You may see this notice: “Changing 
the type or detail type of an account 
may affect your accounting and 
reporting. Are you sure you want to 
do this?”

▪▪ Yes. The NARPM® COA is, by design, 
treating accounts in a slightly different 
way than QBO’s default COA. 

◦◦ Lines with no red fields: 

http://www.pmprofitcoach.com/coa
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▪▪ Often these are sub-accounts of 
other accounts that had import errors. 
Correct the parent account error, and 
these will be imported.

▪▪ If a sub-account is set to a different 
Type/Detail Type than its parent 
account, it will not import but will 
also not show a red field. Review the 
COA PDF to see if this is the issue. 
We worked to eliminate this error, but 
please let us know if you experience it.

•	 To fix import errors, correct any red fields and 
click Import again.

Take It for a Spin
Start coding transactions to the new COA, but 
leave your historical accounts alone for a while — 
perhaps a month or two. Use this time to become 
thoroughly comfortable with the new system. Once 
you’re familiar with it and enthusiastic about it, 
move to the next step.

Merge Every Old Account with a New 
Account
Note: Before beginning the merge, we recommend 
that you compare your current COA to the 
NARPM® COA and determine how each account 
corresponds. In most cases, one or more original 
accounts will merge with one corresponding 
NARPM® account. Some accounts will be able 
to merge directly, while others may be added 
as decimal subaccounts. In some cases, you 
may need to break out individual transactions 
or vendors within one original account to two or 
more NARPM® accounts. Complete this exercise 
before beginning the merge to have a clear map 
of your merge process.

•	 Have the import CSV file and the results of 
your merge mapping (above) available for 
easy reference.

•	 Navigate to Accounting > Chart of Accounts.

•	 To merge accounts:
◦◦ Search for the account name of the old 
account to pull it up in QBO.

▪▪ If it has subaccounts, these will need 
to be disassociated before merging. 
To do this:

▫▫ Search for the account name of 
the subaccount.

▫▫ Click the dropdown arrow next to 
“Run report” and select “Edit”.

▫▫ Uncheck the “Is subaccount” 
checkbox.

▫▫ Save and close.
◦◦ Click the dropdown arrow next to “Run 
report” and select “Edit”.

◦◦ Change the Name and Detail Type to 
match the account with which it will merge.

▪▪ NOTE: Do NOT enter the account 
number.

◦◦ If merging with a subaccount, set the 
parent account to match.

◦◦ Click “Save” and “Yes” to confirm the merge.

•	 To turn an old account into a subaccount of a 
new account:

◦◦ Locate the four-digit number of the new 
account (e.g. 4221).

◦◦ Search for the account name of the old 
account.

◦◦ Click the dropdown arrow next to “Run 
report” and select “Edit”.

◦◦ In the account number field, enter the 
number of the new parent account, a 
decimal point, and a two-digit identifier for 
the subaccount (e.g. 4221.01).

◦◦ Check the “Is subaccount” checkbox and 
set it as a subaccount to the new account 
(e.g. 4221.01 is now a subaccount of 
4221).

◦◦ Save and close.

You’re done! Start operating with the new NARPM® 
COA.
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QuickBooks Online Instructions: 
Option 2 

Turn On Account Numbering (If Needed)
•	 In QuickBooks Online, navigate to the gear 

icon > Account and Settings > Advanced.

•	 Under “Chart of accounts” (third section on the 
list), check that “Enable account numbers” is 
set to “On.” 

◦◦ If “Enable account numbers” is set to “Off”: 
▪▪ Click the pencil icon on the right side 
of the page across from “Chart of 
accounts”.

▪▪ Check the box for “Enable account 
numbers”.

▪▪ Check the resulting box for “Show 
account numbers”.

▪▪ Click “Save” and close out of the 
Account and Settings view.

Import All New Accounts
•	 Download the NARPM® COA CSV file. This 

file is preformatted for import with the following 
fields:

◦◦ Account Number (e.g. 4100)
◦◦ Account Name (e.g. Residential PM 
Income)

◦◦ Type (e.g. Income)
◦◦ Detail Type (e.g. Service/Fee Income)

•	 Select the gear icon and click “Import Data” in 
the Tools column.  

•	 Select “Chart of Accounts”.

•	 Browse for the CSV file and select it. Click 
“Next”.

•	 Map the columns (use the column names 
above). Click “Next”.

•	 Review and click “Import”.

•	 If there are import errors, QBO will display only 
the lines with errors and will highlight the fields 
causing trouble in red.

◦◦ Account Number: There should be no 
Account Number issues in importing this 
file. 

◦◦ Account Name: This indicates that an 
account already exists with that name. 
Typical accounts caught here: Accounts 
Receivable, Retained Earnings, Fixed 
Assets, Interest Income, Interest Expense, 
Opening Balance Equity, Amortization.  
These accounts will not import.

▪▪ For each duplicate account, navigate 
to QBO’s Chart of Accounts, locate 
the account, and edit it to match the 
number, type, and detail type found in 
the imported COA. 

◦◦ Type/Detail Type: These will be red if they 
don’t exactly match QBO’s categories. We 
worked to eliminate all Type/Detail Type 
errors, but please let us know if you have 
this error and which account the error 
appeared on. To fix, simply choose the 
closest match from the dropdown menu.

▪▪ You may see this notice: “Changing 
the type or detail type of an account 
may affect your accounting and 
reporting. Are you sure you want to 
do this?”

▪▪ Yes. The NARPM® COA is, by design, 
treating accounts in a slightly different 
way than QBO’s default COA. 

◦◦ Lines with no red fields: 
▪▪ Often these are sub-accounts of 
other accounts that had import errors. 
Correct the parent account error, and 
these will be imported.

▪▪ If a sub-account is set to a different 
Type/Detail Type than its parent 
account,  it will not import but will 
also not show a red field. Review the 
COA PDF to see if this is the issue. 
We worked to eliminate this error, but 
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please let us know if you experience 
it.

•	 To fix import errors, correct any red fields and 
click Import again.

Take It For a Spin
Start coding transactions to the new COA, but leave 
your historical transactions alone for a while—
perhaps a month or two. Use this time to become 
thoroughly comfortable with the new system. Once 
you’re familiar with it and enthusiastic about it, 
move to the next step.

Merge Every Old Account with a New 
Account
Note: Before beginning the merge, we recommend 
that you compare your current COA to the 
NARPM® COA and determine how each account 
corresponds. In most cases, one or more original 
accounts will merge with one corresponding 
NARPM® account. Some accounts will be able 
to merge directly, while others may be added 
as decimal subaccounts. In some cases, you 
may need to break out individual transactions or 
vendors within one original account to two or more 
NARPM® accounts. Complete this exercise before 
beginning the merge to have a clear map of your 
merge process. 

•	 Have the results of your merge mapping 
(above) available for easy reference.

•	 Navigate to Accounting > Chart of Accounts.

•	 To merge accounts:
◦◦ Search for the account name of the old 
account to pull it up in QBO.

▪▪ If it has subaccounts, these will need 
to be disassociated before merging. 
To do this:

▫▫ Search for the account name of 
the subaccount.

▫▫ Click the dropdown arrow next to 

“Run report” and select “Edit”.
▫▫ Uncheck the “Is subaccount” 
checkbox.

▫▫ Save and close.
◦◦ Change the Name and Detail Type to 
match the account with which it will merge.

◦◦ Click “Save” and “Yes” to confirm the 
merge.

•	 To turn an old account into a subaccount of a 
new:

◦◦ Locate the four-digit number of the new 
account (e.g. 4221).

◦◦ Search for the account name of the old 
account.

◦◦ Click the dropdown arrow next to “Run 
report” and select “Edit”.

◦◦ In the account number field, enter the 
number of the new parent account, a 
decimal point, and a two-digit identifier for 
the subaccount (e.g. 4221.01).

◦◦ Check the “Is subaccount” checkbox and 
set it as a subaccount to the new account 
(e.g. 4221.01 is now a subaccount of 
4221).

◦◦ Save and close.

Reclassify Transactions to the NARPM® 
Categories 
Choose one of the following two methods:

•	 (1) Use the Reclassification Tool (requires 
Accountant user access to QBO).

◦◦ Have the results of your merge mapping 
available for easy reference.

◦◦ Navigate to the briefcase icon near 
the top left of the screen > Reclassify 
Transactions.

◦◦ Set the date range for the range desired 
to change.

◦◦ Select an account containing transactions 
that need to be reclassified.
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◦◦ Select all transactions that will be 
reclassified to the same account (e.g. 
if you’re reclassifying transactions in 
“Marketing”, and some transactions will 
be reclassified to Website while other 
transactions will be reclassified to other 
accounts, select all transactions to be 
reclassified to Website).

◦◦ At the bottom right of the screen, check 
the “For all selected transactions, change” 
checkbox.

◦◦ Select the new account (e.g. Website) 
from the dropdown.

◦◦ Click “Reclassify”.
◦◦ Repeat as needed until all transactions 
are reclassified to the correct account in 
the NARPM® COA. 

•	 (2) Manually reclassify transactions (does not 
require Accountant user access).

◦◦ This options requires that you reclassify 
transactions one at a time: 

▪▪ Open the transaction. 
▪▪ Change the account to the new/
correct account name. 

▪▪ Save and close.

You’re done! Start operating with the new NARPM® 
COA. 

QuickBooks Online Troubleshooting
For troubleshooting help, visit www.PMProfitCoach.com/coa.

http://www.pmprofitcoach.com/coa
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QuickBooks Desktop 
Instructions: Option 1

BEFORE MAKING ANY CHANGES:
Make a backup copy of your company file.

Turn On Account Numbering (If Needed)
•	 In QuickBooks, navigate to Edit > Preferences 

> Accounting > Company Preferences.

•	 Under “Accounts” (first section), check that 
“Use account numbers” is checked. 

◦◦ If it is not already checked, check it.

Import All New Accounts
•	 Download the NARPM® COA CSV file from 

our custom chart of accounts generator here: 
www.PMProfitCoach.com/coa. This file is 
preformatted for import with the following fields:

◦◦ Type (e.g. Income)
◦◦ Account Number (e.g. 4100)
◦◦ Account Name (e.g. Residential PM 
Income)

•	 Navigate to File > Utilities > Import > Excel 
Files.

•	 Select “Advanced Import” on the right side 
of the dialog box to open the “Import a file” 
window.

•	 Click “Browse” and locate/select the NARPM® 
COA CSV file.

•	 Wait a few seconds for it to load. You should 
see a “Starting Excel” notification appear on 
the screen. If not, try clicking any blank space 
in the “Import a file” window to push it forward.

•	 In the dropdown menu under “Choose a sheet 
in this Excel workbook”, select the sheet to 
import. There should only be one option.

•	 Under the “Choose a mapping” dropdown, 
select “< Add New >”. A new “Mappings” 
window will open.

•	 For the mapping name, enter “NARPM COA”.

•	 For the import type, select “Account”.

•	 Map the columns to the QuickBooks fields.
◦◦ Type > Type
◦◦ Account Number > Number
◦◦ Account Name > Name

•	 Save.

•	 Click Preview and review for errors. 
◦◦ If there are errors, choose the option “Do 
not import rows with errors.”

•	 Click “Import”.
◦◦ If the system warns you of duplicate 
entries during import, choose the option 
to keep the original and discard the new 
import entry.

•	 When the system notifies you that the import 
is complete, take note if there are errors 
and save the error log to your desktop or 
other easily locatable spot. Open the error 
log and review column D for the specific 
errors. For troubleshooting help, visit 
www.PMProfitCoach.com/coa.

•	 Navigate back to Edit > Preferences > 
Accounting > Company Settings and check the 
box for “Show lowest subaccount only”.

QuickBooks Desktop Instructions

http://www.pmprofitcoach.com/coa
http://www.pmprofitcoach.com/coa
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Take It for a Spin
Start coding transactions to the new COA, but leave 
your historical transactions alone for a while—
perhaps a month or two. Use this time to become 
thoroughly comfortable with the new system. Once 
you’re familiar with it and enthusiastic about it, 
move to the next step.

Merge Every Old Account with a New 
Account
Note: Before beginning the merge, we recommend 
that you compare your current COA to the 
NARPM® COA and determine how each account 
corresponds. In most cases, one or more original 
accounts will merge with one corresponding 
NARPM® account. Some accounts will be able 
to merge directly, while others may be added 
as decimal subaccounts. In some cases, you 
may need to break out individual transactions or 
vendors within one original account to two or more 
NARPM® accounts. Complete this exercise before 
beginning the merge to have a clear map of your 
merge process.

•	 Have the results of your merge mapping 
(above) available for easy reference.

•	 Navigate to Lists > Chart of Accounts.

•	 To merge bank accounts into the NARPM® 
structure:

◦◦ The bank accounts should be at the top of 
the QuickBooks COA.

◦◦ For the primary operating account:
▪▪ Select your operating account.
▪▪ Click the dropdown arrow next to 
“Account” at the lower left corner of 
the window and select “Edit Account”.

▪▪ Add the account number 1110. Set as 
subaccount of 1100—Cash.

▪▪ Save and close.
▪▪ Delete the NARPM “1110—Cash 
Account 1.”

◦◦ For all other bank accounts: 
▪▪ Edit the account and add the account 
number as the next increment of 10 
(e.g. 1120). Set as subaccount of 
1100—Cash.

▪▪ Save and close.

•	 To merge accounts:
◦◦ Search for the account name of the old 
account to pull it up in QuickBooks.

▪▪ Enter the account name in the search 
field under “Look for account name or 
number” and click “Search”.

◦◦ If it has subaccounts, these will appear 
in the search results and will need to be 
disassociated before merging. To do this:

▪▪ Select the subaccount from the COA 
search results.

▪▪ Click the dropdown arrow next to 
“Account” at the lower left corner of 
the window and select “Edit Account”.

▪▪ Uncheck the “Subaccount of ” 
checkbox (remember the parent 
account if you want to recreate the 
hierarchy).

▪▪ Save and close.
◦◦ Change the Detail Type to match the 
account with which it will merge.

◦◦ Enter the number of the account with 
which it will merge.

◦◦ If applicable, set as a subaccount to the 
parent of the account with which it will 
merge.

◦◦ Click “Save” and “Yes” to confirm the 
merge.

◦◦ If it had subaccounts, locate the old 
subaccounts and recreate the hierarchy.

▪▪ Search for the name of the 
old subaccount. Select the old 
subaccount.

▪▪ Click the dropdown arrow next to 
“Account” at the lower left corner of 
the window and select “Edit Account”.
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▪▪ Check the “Subaccount of ” checkbox 
and enter the name of the new parent 
account.

▪▪ Save and close.

•	 To turn an old account into a subaccount of a 
new:

◦◦ Locate the four-digit number of the new 
account (e.g. 4221).

◦◦ Search for and select the old account in 
the QuickBooks COA.

◦◦ Click the dropdown arrow next to “Account” 
at the lower left corner of the window and 
select “Edit Account”.

◦◦ In the account number field, enter the 
number of the new parent account, a 
decimal point, and a two-digit identifier for 
the subaccount (e.g. 4221.01).

◦◦ Check the “Subaccount of” checkbox and 
set it as a subaccount to the new account 
(e.g. 4221.01 is now a subaccount of 
4221).

◦◦ Save and close.

You’re done! Start operating with the new NARPM® 
COA.
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QuickBooks Desktop 
Instructions: Option 2

BEFORE MAKING ANY CHANGES:
Make a backup copy of your company file.

Turn On Account Numbering (If Needed)
•	 In QuickBooks, navigate to Edit > Preferences 

> Accounting > Company Preferences.

•	 Under “Accounts” (first section), check that 
“Use account numbers” is checked.

◦◦ If it is not already checked, check it.

Import All New Accounts
•	 Download the NARPM® COA CSV file from 

our custom chart of accounts generator here: 
www.PMProfitCoach.com/coa. This file is 
preformatted for import with the following fields:

◦◦ Type (e.g. Income)
◦◦ Account Number (e.g. 4100)
◦◦ Account Name (e.g. Residential PM 
Income)

•	 In QuickBooks, navigate to File > Utilities > 
Import > Excel Files.

•	 Select “Advanced Import” on the right side 
of the dialog box to open the “Import a file” 
window.

•	 Click “Browse” and locate/select the NARPM® 
COA CSV file.

•	 Wait a few seconds for it to load. You should 
see a “Starting Excel” notification appear on 
the screen. If not, try clicking any blank space 
in the “Import a file” window to push it forward.

•	 In the dropdown menu under “Choose a sheet 
in this Excel workbook”, select the sheet to 
import. There should only be one option.

•	 Under the “Choose a mapping” dropdown, 

select “< Add New >”. A new “Mappings” 
window will open.

•	 For the mapping name, enter “NARPM COA”.

•	 For the import type, select “Account”.

•	 Map the columns to the QuickBooks fields.
◦◦ Type > Type
◦◦ Account Number > Number
◦◦ Account Name > Name

•	 Save.

•	 Click Preview and review for errors.
◦◦ If there are errors, choose the option “Do 
not import rows with errors.”

•	 Click “Import”.
◦◦ If the system warns you of duplicate 
entries during import, choose the option 
to keep the original and discard the new 
import entry.

•	 When the system notifies you that the import 
is complete, take note if there are errors 
and save the error log to your desktop or 
other easily locatable spot. Open the error 
log and review column D for the specific 
errors. For troubleshooting help, visit 
www.PMProfitCoach.com/coa.

•	 Navigate back to Edit > Preferences > 
Accounting > Company Settings and check the 
box for “Show lowest subaccount only”.

Take It for a Spin
Start coding transactions to the new COA, but leave 
your historical transactions alone for a while—
perhaps a month or two. Use this time to become 
thoroughly comfortable with the new system. Once 
you’re familiar with it and enthusiastic about it, 
move to the next step.

Merge Every Old Account with a New 
Account

http://www.pmprofitcoach.com/coa
http://www.pmprofitcoach.com/coa
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Note: Before beginning the merge, we recommend 
that you compare your current COA to the 
NARPM® COA and determine how each account 
corresponds. In most cases, one or more original 
accounts will merge with one corresponding 
NARPM® account. Some accounts will be able 
to merge directly, while others may be added 
as decimal subaccounts. In some cases, you 
may need to break out individual transactions or 
vendors within one original account to two or more 
NARPM® accounts. Complete this exercise before 
beginning the merge to have a clear map of your 
merge process.

•	 Have the results of your merge mapping 
(above) available for easy reference.

•	 Navigate to Lists > Chart of Accounts.

•	 To merge bank accounts into the NARPM® 
structure:

◦◦ The bank accounts should be at the top of 
the QuickBooks COA.

◦◦ For the primary operating account:
▪▪ Select your operating account.
▪▪ Click the dropdown arrow next to 
“Account” at the lower left corner of 
the window and select “Edit Account”.

▪▪ Add the account number 1110. Set as 
subaccount of 1100—Cash.

▪▪ Save and close.
▪▪ Delete the NARPM “1110—Cash 
Account 1.”

◦◦ For all other bank accounts:
▪▪ Edit the account and add the account 
number as the next increment of 10 
(e.g. 1120). Set as subaccount of 
1100 Cash.

▪▪ Save and close.

•	 To merge accounts:
◦◦ Search for the account name of the old 
account to pull it up in QuickBooks.

▪▪ Enter the account name in the search 

field under “Look for account name or 
number” and click “Search”.

◦◦ If it has subaccounts, these will appear 
in the search results and will need to be 
disassociated before merging. To do this:

▪▪ Select the subaccount from the COA 
search results.

▪▪ Click the dropdown arrow next to 
“Account” at the lower left corner of 
the window and select “Edit Account”.

▪▪ Uncheck the “Subaccount of ” 
checkbox (remember the parent 
account if you want to recreate the 
hierarchy).

▪▪ Save and close.
◦◦ Change the Number and Detail Type to 
match the account with which it will merge.

◦◦ Click “Save” and “Yes” to confirm the 
merge.

◦◦ If it had subaccounts, locate the old 
subaccounts and recreate the hierarchy.

▪▪ Search for the name of the 
old subaccount. Select the old 
subaccount.

▪▪ Click the dropdown arrow next to 
“Account” at the lower left corner of 
the window and select “Edit Account”.

▪▪ Check the “Subaccount of ” checkbox 
and enter the name of the new parent 
account.

▪▪ Save and close.

•	 To turn an old account into a subaccount of a 
new:

◦◦ Locate the four-digit number of the new 
account (e.g. 4221).

◦◦ Search for and select the old account in 
the QuickBooks COA.

◦◦ Click the dropdown arrow next to “Account” 
at the lower left corner of the window and 
select “Edit Account”.

◦◦ In the account number field, enter the 
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QuickBooks Desktop Troubleshooting
For troubleshooting help, visit www.PMProfitCoach.com/coa.

number of the new parent account, a 
decimal point, and a two-digit identifier for 
the subaccount (e.g. 4221.01).

◦◦ Check the “Subaccount of” checkbox and 
set it as a subaccount to the new account 
(e.g. 4221.01 is now a subaccount of 
4221).

◦◦ Save and close.

Reclassify Transactions to the NARPM® 
Categories
Choose one of the following two methods.

•	 (1) Use the Batch Reclassify Tool (requires 
QuickBooks Enterprise or QuickBooks Desktop 
Accountant):

◦◦ Have the results of your merge mapping 
available for easy reference.

◦◦ Navigate to Accountant (from the top 
ribbon menu) > Client Data Review > 
Reclassify Transactions.

◦◦ Set the date range for the range desired 
to change.

◦◦ In the dropdown menu below the date 
range, make sure the right type of account 
(e.g. Profit & Loss, Expense) is set to 
display.

◦◦ From the account listing on the left side, 
select an account containing transactions 
that need to be reclassified.

◦◦ From the transaction listing in the main 
pane, select all transactions that will be 
reclassified to the same account (e.g. 
if you’re reclassifying transactions in 
“Marketing”, and some transactions will 
be reclassified to Website while other 
transactions will be reclassified to other 
accounts, select all transactions to be 
reclassified to Website).

◦◦ At the bottom of the pane, check the 
“For all selected transactions, change” 
checkbox.

◦◦ Select the new account (e.g. Website) 
from the dropdown.

◦◦ Click “Reclassify”.
◦◦ Repeat as needed until all transactions 
are reclassified to the correct account in 
the NARPM® COA.

•	 (2) Manually reclassify transactions (does not 
require Enterprise or Desktop Accountant user 
access).

◦◦ This options requires that you reclassify 
transactions one at a time:

▪▪ Open the individual transaction.
▪▪ Change the account to the new/
correct account name.

▪▪ Save and close.

You’re done! Start operating with the new NARPM® 
COA.

http://www.pmprofitcoach.com/coa
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Chart of Accounts
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2019 Copyright © NARPM®

1000 ASSETS SECTION OVERVIEW: Includes all assets.

1100 Cash SECTION OVERVIEW: Includes all cash.

1110 Cash Account 1
Includes operating bank accounts and any other type of bank account used 
for the operations of the business. Trust accounts are not included.

1200 Accounts Receivable
The balance of amounts owed to the company for goods or services 
delivered but not yet paid for by customers.

1210 Allowance for 
Bad Debt

Estimate of receivables that will not be collected from customers.

1299 Other 
Receivables

Refers to amounts owed to the company for anything other than goods or 
services delivered.

1300 Inventory Asset Goods held for sale.

1400 Other Current Assets SECTION OVERVIEW: Includes all other current assets.

1410 Advances to 
Employees

Advance payment to employees, to be repaid by reimbursement or payroll 
withholdings.

1420 Loan to 
Shareholder

Funds lent to a shareholder expected to be repaid within a year. This is a 
sticky account for tax/possible audit purposes, so be sure to maintain clear 
documentation.

1430 Prepaid Expense

Used in accrual accounting for a future expense paid in advance and then 
charged to expense over the usage period. For example, XYZ Company 
acquires a $1200 insurance policy covering a 12-month period. Instead 
of expensing the full $1200 in month 1, only $100 would be expensed 
in month 1 while the remaining $1100 is coded to Prepaid Expense and 
expensed in $100 monthly increments over the duration of the policy. A 
best practice is to use Prepaid Expense only for larger expenses that will 
be used up within a year. Set your own threshold for what is considered 
“larger” — what makes sense in your context. For example, a threshold of 
$1000 means that future expenses under $1000 are directly expensed while 
future expenses at or over $1000 are treated as Prepaid Expenses. Put the 
threshold in writing and enforce it.

1440 Reimbursable 
Expense

Expenses paid out of pocket by the property management company to be 
reimbursed by owners or tenants.

1450 Undeposited 
Funds

Undeposited Funds is a special account created by QuickBooks as 
a clearing account for payments that have been received but not yet 
deposited into the bank account. The easiest way to picture this account is 
as the top desk drawer.



21

# Parent Child Sub-Child Definition Notable Exclusions

2019 Copyright © NARPM®

1499 Other Current 
Assets - Other

Includes Other Current Assets that are not otherwise categorized. NOTE: 
Up to 99 additional decimal subaccounts may be added under this account.

1510 Loan Receivable 
1

Refers to funds lent by the company expected to be repaid in less than one 
year.

1600 Long-Term Assets SECTION OVERVIEW: Includes all long-term assets.

1610 Security Deposit
Deposits made by the property management company for securing 
such things as office space leases. This does not include tenant security 
deposits.

1699 Long-Term Assets 
- Other

Includes Long-Term Assets that are not otherwise categorized. NOTE: Up 
to 99 additional decimal subaccounts may be added under this account.

1700 Fixed Assets SECTION OVERVIEW: Includes all fixed assets.

1710 Accumulated 
Depreciation

Accumulation of depreciation expense. The net of fixed assets and 
accumulated depreciation is the book value of the assets.

1720 Building
Depreciable cost of any enclosed structures with a roof; includes all 
attached systems (e.g. HVAC); does not include the land.

1730 Building 
Improvements

Depreciable cost of major repairs or improvements that either increase the 
value or extend the useful life of the building.

1740 Computers & 
Software

Depreciable cost of computers, purchased software, and other technology. 
Every business needs to set a capitalization policy with a specific 
threshold. We recommend consulting with a tax advisor to ensure that the 
capitalization policy aligns with tax regulations. If a computer or technology 
expenditure is under the policy threshold, expense it. If the expenditure is 
over the policy threshold, code it here for future depreciation.

1750 Furniture

Depreciable cost of movable furniture not attached to the structure of the 
building. Every business needs to set a capitalization policy with a specific 
threshold. We recommend consulting with a tax advisor to ensure that the 
capitalization policy aligns with tax regulations. If a furniture expenditure is 
under the policy threshold, expense it. If the expenditure is over the policy 
threshold, code it here for future depreciation.

1760 Land
Cost of real property plus any improvements needed to make it ready for 
use. Not depreciated.



22

# Parent Child Sub-Child Definition Notable Exclusions

2019 Copyright © NARPM®

1770 Other Equipment

Other depreciable equipment (meeting thresholds for cost and useful 
life). Every business needs to set a capitalization policy with a specific 
threshold. We recommend consulting with a tax advisor to ensure that the 
capitalization policy aligns with tax regulations. If an equipment expenditure 
is under the policy threshold, expense it. If the expenditure is over the policy 
threshold, code it here for future depreciation.

1780 Vehicles Depreciable cost of vehicles purchased for company use.

1799 Fixed Assets - 
Other

Includes Fixed Assets that are not otherwise categorized. NOTE: Up to 99 
additional decimal subaccounts may be added under this account.

1800 Intangible Assets SECTION OVERVIEW: Includes all intangible assets.

1810 Accumulated 
Amortization

Accumulation of amortization expense recorded against intangible assets.

1820 Goodwill
The excess cost of an acquisition above the fair value of the net assets 
purchased.

1830 Leasehold 
Improvements

Tenant-paid improvements to leased space.

1840 Organization 
Costs

Costs to organize or incorporate the property management company.

1850 Other Company 
Acquisition Costs

Includes other types of acquisition costs not referenced specifically in 
intangible assets.

1899 Intangible Assets 
- Other

Includes Intangible Assets that are not otherwise categorized. NOTE: Up to 
99 additional decimal subaccounts may be added under this account.

2000 LIABILITIES SECTION OVERVIEW: Includes all liabilities.

2100 Accounts Payable Short-term amounts due to suppliers, lenders, or other creditors.

2200 Credit Cards

2210 Credit Card 1 Credit card(s) used for company purchases.

2300 Other Current Liabilities

2310 Line of Credit 1
Credit extended to the property management company from a financial 
institution.

2410 Short-Term Loan 
1

Loan to be repaid within a year.
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2510 Accrued Expense

Used in accrual accounting for expenses incurred but not yet paid: e.g. 
wages payable, interest payable. For example, XYZ Company makes a 
$500 loan interest payment for the month of December on the 5th of the 
following month of January. XYZ has an accounting year-end of December 
31 and wants to recognize the interest expense of $500 in the financial 
statements of that year, even though it was paid in the following year. This 
expense is accrued in December by recording a journal entry debiting 
interest expense and crediting Accrued Expenses. The payment issued 
on the 5th of January will be coded to Accrued Expenses, thereby zeroing 
out the liability. A best practice is to use Accrued Expenses only for larger 
expenses that will be due within a year. Set your own threshold for what is 
considered “larger” — what makes sense in your context. For example, a 
threshold of $500 means that future expenses under $500 will be expensed 
when paid, while future expenses at or over $500 are treated as Accrued 
Expenses. Put the threshold in writing and enforce it.

2520 Earnest Money 
Payable

Used for earnest money payments made to the property management 
company brokering a real estate transaction.

2530 Loan from 
Shareholder

Loan to the company from the shareholder which must be repaid within the 
year. This is a sticky account for tax/possible audit purposes, so be sure to 
maintain clear documentation.

2540 Payroll Liabilities

Accrued payroll taxes (employer or withheld), benefits, and garnishments 
to be remitted. The most common of these are included in the following 
list. If desired, you break out these payroll liabilities using up to 99 decimal 
subaccounts (e.g. 2540.01 - Federal Withholding). 
- 401(k) 
- Child Support 
- Dental 
- Direct Deposit Payable 
- Federal Withholding 
- FICA (Employee and employer portion of social security and medicare tax) 
- FUTA (Federal unemployment tax) 
- Local Withholding 
- S-Corp Health Insurance 
- State Withholding 
- SUTA (State unemployment tax (employer)) 
- Wage Garnishment 
- Worker’s Compensation

2550 Retirement Plan 
Payable

Amount owed for the company’s retirement plan.
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2560 Sales Tax 
Payable

Refers to the sales taxes that a business has collected from customers on 
behalf of a governing tax authority. The business is the custodian of these 
funds and is liable for remitting them to the government on a timely basis.

2599 Other Current 
Liabilities - Other

Includes Other Current Liabilities that are not otherwise categorized. NOTE: 
Up to 99 additional decimal subaccounts may be added under this account.

2600 Long-Term Liabilities SECTION OVERVIEW: Includes all long-term liabilities.

2610 Note Payable 1 Unpaid principal on outstanding promissory note(s).

2699 Long-Term 
Liabilities - Other

Includes Long-Term Liabilities that are not otherwise categorized. NOTE: 
Up to 99 additional decimal subaccounts may be added under this account.

3000 EQUITY SECTION OVERVIEW: Includes all equity.

3010 Owner’s Capital Owner’s interest in a sole proprietorship or LLC.

3020 Owner’s Draw Owner’s withdrawals from a sole proprietorship or LLC.

3030 Owner 
Contributions

Owner’s interest in an S-corp.

3040 Owner 
Distributions

Owner’s withdrawals from an S-corp.

3050 Capital Shareholders’ interest in a corporation.

3051 Additional Paid-In 
Capital

Additional (above par) gain on sales of stock.

3052 Common Stock Par value of sales of common stock.

3053 Preferred Stock Par value of sales of preferred stock.

3054 Treasury Stock Par value of repurchased stock.

3060 Dividends Shareholders’ portion of corporation profits.

3070 Opening Balance 
Equity

Default Quickbooks account created during the initial Quickbooks setup 
to record the opening balances of bank or credit accounts. This should 
be zeroed out by a journal entry that moves these balances to the 
corresponding equity account — move the opening bank balances to a 
capital/contributions account and the opening credit balances to a draw/
distributions account.
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3080 Retained 
Earnings

Accumulated profit less owner draws/owner distributions/dividends.

3090 Net Income Profit from the income statement.

3099 Equity - Other
Includes Equity that is not otherwise categorized. NOTE: Up to 99 additional 
decimal subaccounts may be added under this account.

4000 INCOME SECTION OVERVIEW: Includes all operating income.

4100 Residential PM Income
SECTION OVERVIEW: Includes all income from residential long-term rental 
property management.

Does not include Commercial PM 
Income, Community Association PM 
Income, Lease Only (or Placement 
Only) Income, or Maintenance Income. 
NOTE: Reimbursement for pass-through 
expenses should not be booked as income 
anywhere in the income section of the 
COA. All reimbursable expenses and 
reimbursements from owners or tenants 
should be booked to 1440 - Reimbursable 
Expense (on the balance sheet).

4110 Management 
Fees

Includes income from the base management fee.
Does not include any ancillary fees. Only 
the base management fee.

4120 Ancillary Fees Parent account for all Residential PM Ancillary Fees.

4121 Application Fees Includes Application Fees income.

Does not include any offsetting application 
fee expenses. Offsetting application fee 
expenses should be booked below under 
6611 - Application Fees Expense.

4122 Leasing Fees Includes Leasing Fees income.

Does not include any offsetting leasing 
commissions expenses. Leasing 
commissions should be booked in the 
Direct Labor (6300s) section below.

4123 Renewal Fees Includes Renewal Fees income.

4124 Other Owner 
Paid Fees

Includes all other Owner Paid Fees. NOTE: Up to 99 additional decimal 
subaccounts may be added to break out owner paid fees into individual 
accounts (e.g. 4124.01 - Eviction Protection Program).

Does not include any offsetting cost of 
services expenses. These should be 
booked under Direct PM Expense (6610s).

4125 Other Tenant 
Paid Fees

Includes all other Tenant Paid Fees: NOTE: Up to 99 additional decimal 
subaccounts may be added to break out tenant paid fees into individual 
accounts (e.g. 4125.01 - NSF Fees).

Does not include any offsetting cost of 
services expenses. These should be 
booked under Direct PM Expense (6610s).
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4126

Owner 
Maintenance 
Coordination 
Fees

Includes income from adding a markup or upcharge to owners on 3rd-party 
maintenance vendor bills.

Does not include the pass-through portion 
of any bill for 3rd-party maintenance 
services billed directly from the 3rd-party 
vendor to the owner. Such pass-through 
maintenance expenses should be booked 
to 1440 - Reimbursable Expense.

4127
Vendor 
Maintenance 
Referral Income

Includes referral income received from 3rd-party maintenance vendors. This 
may include (but is not limited to) Prompt Payment Discounts and Vendor 
Marketing Programs, etc.

4129 Other Fees
Includes other fees which are not exclusively either owner paid or tenant 
paid fees. NOTE: Up to 99 additional decimal subaccounts may be added 
to break out other fees into individual accounts.

4199 Residential PM 
Income - Other

Includes Residential PM Income that is not otherwise categorized. NOTE: 
Up to 99 additional decimal subaccounts may be added under this account.

4200 Other PM Income
SECTION OVERVIEW: Includes all property management income that is 
not included in Residential PM Income.

4220 Commercial PM 
Income

Parent account for all Commercial PM Income.

4221
Commercial 
Management 
Fees

Includes income from the base commercial management fee.

4222 Commercial 
Ancillary Fees

Includes income from all commercial management ancillary fees.

4223
Commercial 
Maintenance 
Income

Includes maintenance markup, referral, or services income from commercial 
properties under management.

4229 Commercial PM 
Income - Other

Includes Commercial PM Income that is not otherwise categorized. NOTE: 
Up to 99 additional decimal subaccounts may be added under this account.

4230 CA PM Income Parent account for all Community Association PM Income.

4231 CA Management 
Fees

Includes income from the base community association management fee.

4232 CA Ancillary Fees
Includes income from all community association management ancillary 
fees.

4233 CA Maintenance 
Income

Includes maintenance markup, referral, or services income from community 
associations under management.
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4239 CA PM Income - 
Other

Includes Community Association PM Income that is not otherwise 
categorized. NOTE: Up to 99 additional decimal subaccounts may be added 
under this account.

4240 Short-Term PM 
Income

Parent account for all Short-Term PM Income.

4241
Short-Term 
Management 
Fees

Includes income from the base short-term management fee.

4242 Short-Term 
Ancillary Fees

Includes income from all short-term management ancillary fees.

4243
Short-Term 
Maintenance 
Income

Includes maintenance markup, referral, or services income from short-term 
properties under management.

4249 Short-Term PM 
Income - Other

Includes Short-Term PM Income that is not otherwise categorized. NOTE: 
Up to 99 additional decimal subaccounts may be added under this account.

4250 Lease Only Fees Includes gross income from lease- or placement-only services.

Does not include any offsetting leasing 
commissions expenses. Leasing 
commissions should be booked in the 
Direct Labor (6300s) section below.

4260 PM Referral 
Income

Includes income from referring owner or tenant leads to another property 
management company.

4299 Other PM Income 
- Other

Includes Other PM Income that is not otherwise categorized. NOTE: Up to 
99 additional decimal subaccounts may be added under this account.

4700 Maintenance Income
SECTION OVERVIEW: Includes maintenance services income derived 
from residential properties under management.

4710 Maintenance & 
Repairs Income

Includes income from maintenance and repairs services provided by 
in-house technicians or 3rd-party vendors (whose services are billed 
to owners directly from the management company). NOTE: Up to 99 
additional decimal subaccounts may be added to break out various types of 
maintenance & repairs services (e.g. 4710.01 - Plumbing).

Does not include reimbursements for 3rd 
party maintenance vendor services that 
are billed directly from the vendor to the 
owner and are temporarily covered by the 
management company.

4720
Project 
Coordination 
Income

Includes income from maintenance project coordination.

4799 Maintenance 
Income - Other

Includes Maintenance Income that is not otherwise categorized. NOTE: Up 
to 99 additional decimal subaccounts may be added under this account.

4800 Brokerage Income
SECTION OVERVIEW: Includes all income from real estate brokerage 
services.
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4810 PM Brokerage 
Income

Includes income from brokerage services, related to owners or tenants 
receiving in-house property management services.

Does not include income from brokerage 
clients not receiving property management 
services.

4811 PM Brokerage 
Listing Income

Includes income from brokerage listing commissions, related to owners or 
tenants receiving in-house property management services.

Does not include any offsetting brokerage 
listing commissions expenses. Brokerage 
commissions expenses should be 
booked in either the Brokerage COS 
(5800s) section (for contractors) or 6870 - 
Brokerage Wages (for W2 Employees).

4812 PM Brokerage 
Sales Income

Includes income from brokerage sales commissions from owners or tenants 
receiving in-house property management services.

Does not include any offsetting brokerage 
listing commissions expenses. Brokerage 
commissions expenses should be 
booked in either the Brokerage COS 
(5800s) section (for contractors) or 6870 - 
Brokerage Wages (for W2 Employees).

4813 PM Brokerage 
Referral Income

Includes income from referring brokerage listing or sales leads to another 
brokerage, related to owners or tenants receiving in-house property 
management services.

4819 PM Brokerage 
Income - Other

Includes PM Brokerage Income that is not otherwise categorized. NOTE: 
Up to 99 additional decimal subaccounts may be added under this account.

4820 Other Brokerage 
Income

Includes income from brokerage services related to clients not receiving 
property management services.

4821 Other Brokerage 
Listing Income

Includes income from brokerage listing commissions, related to clients not 
receiving property management services.

Does not include any offsetting brokerage 
listing commissions expenses. Brokerage 
commissions expenses should be 
booked in either the Brokerage COS 
(5800s) section (for contractors) or 6870 - 
Brokerage Wages (for W2 Employees).

4822 Other Brokerage 
Sales Income

Includes income from brokerage sales commissions, related to clients not 
receiving property management services.

Does not include any offsetting brokerage 
listing commissions expenses. Brokerage 
commissions expenses should be 
booked in either the Brokerage COS 
(5800s) section (for contractors) or 6870 - 
Brokerage Wages (for W2 Employees).

4823 Other Brokerage 
Referral Income

Includes income from referring brokerage listing or sales leads to another 
brokerage, related to clients not receiving property management services.

4829 Other Brokerage 
Income - Other

Includes Other Brokerage Income that is not otherwise categorized. NOTE: 
Up to 99 additional decimal subaccounts may be added under this account.



29

# Parent Child Sub-Child Definition Notable Exclusions

2019 Copyright © NARPM®

4899 Brokerage 
Income - Other

Includes Brokerage Income that is not otherwise categorized. NOTE: Up to 
99 additional decimal subaccounts may be added under this account.

5000 COST OF SERVICES SECTION OVERVIEW: Includes cost of services for residential 
Maintenance and Brokerage departments.

5700 Maintenance COS Parent account for residential maintenance cost of services.

5710 Maintenance 
Contractors COS

Includes cost of sales for 3rd-party vendors whose services are billed to 
owners directly from the management company.

Does not include expenses for 3rd-party 
maintenance vendor services that are 
billed directly from the vendor to the 
owner and are temporarily covered by the 
management company.

5720
Maintenance 
Supplies & 
Materials COS

Includes cost of services for supplies and materials for in-house residential 
maintenance services.

5799 Maintenance 
COS - Other

Includes Maintenance Cost of Services that are not otherwise categorized. 
NOTE: Up to 99 additional decimal subaccounts may be added under this 
account.

5800 Brokerage COS Parent account for Brokerage Cost of Services.

5810
Brokerage 
Commissions 
Paid COS - PM

Includes cost of services for all contractor commissions paid to brokerage 
agents and specialists for brokerage services related to owners or tenants 
receiving in-house property management services.

Does not include W-2 commissions paid 
out to brokerage agents and specialists.

5820
Brokerage 
Commissions 
Paid COS - Other

Includes cost of services for all contractor commissions paid to brokerage 
agents and specialists for brokerage services related to clients not receiving 
in-house property management services.

Does not include W-2 commissions paid 
out to brokerage agents and specialists.

5830 Brokerage 
Royalties COS

Includes cost of services for brokerage royalties.

5840
Brokerage 
Transaction Fees 
COS

Includes cost of services for brokerage transaction fees.

5899 Brokerage COS - 
Other

Includes Brokerage Cost of Services that are not otherwise categorized. 
NOTE: Up to 99 additional decimal subaccounts may be added under this 
account.

6000 EXPENSES SECTION OVERVIEW: Includes all operating expenses.
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6100 Facilities
SECTION OVERVIEW: Includes all property management-related facilities 
expenses.

Does not include any facilities expenses 
exclusively related to Brokerage or 
Maintenance departments. These may be 
separated out into the Direct Brokerage 
or Direct Maintenance expense sections 
below.

6110 Auto Parent account for Auto expenses.
Does not include any maintenance-related 
auto expenses.

6111 Auto Lease Includes auto lease expenses.
Does not include any maintenance-related 
auto expenses.

6112 Auto Repairs & 
Maintenance

Includes auto maintenance and repair expenses.
Does not include any maintenance-related 
auto expenses.

6113 Gas & Mileage 
Reimbursement

Includes gas and mileage reimbursement expenses.
Does not include any maintenance-related 
auto expenses.

6119 Auto - Other
Includes Auto expenses that are not otherwise categorized. NOTE: Up to 99 
additional decimal subaccounts may be added under this account.

Does not include any maintenance-related 
auto expenses.

6120 Office Parent account for Office expenses.

6121 Equipment 
Rental/Lease

Includes equipment rental/lease expenses.
Does not include any maintenance-related 
equipment rental/lease expenses.

6122 Office Equipment Includes office equipment expenses.

6123 Office Furniture Includes office furniture expenses.

6124 Office Rent/Lease Includes office rent or lease expenses.

6129 Office - Other
Includes Office expenses that are not otherwise categorized. NOTE: Up to 
99 additional decimal subaccounts may be added under this account.

Does not include general office supplies. 
Office supplies should be booked under 
6656 - Office Supplies & Expenses.

6130 Office 
Maintenance

Parent account for Office Maintenance expenses.

Does not include any expenses related to 
the maintenance department. This section 
is only for office space maintenance 
expenses.

6131 Cleaning Includes office cleaning expenses.

6132 Landscaping Includes office landscaping expenses.
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6133 Renovations & 
Repairs

Includes office renovations and repairs expenses.

6139
Office 
Maintenance - 
Other

Includes Office Maintenance expenses that are not otherwise categorized. 
NOTE: Up to 99 additional decimal subaccounts may be added under this 
account.

6140 Technology Parent account for Technology expenses.

6141 Hardware Includes computer, server, and network hardware and accessory expenses.

6142 Software Includes desktop and cloud-hosted software expenses.

6149 Technology - 
Other

Includes Technology expenses that are not otherwise categorized. NOTE: 
Up to 99 additional decimal subaccounts may be added under this account.

6150 Utilities Parent account for Utilities expenses.
Does not include any reimbursable utilities 
expenses paid on behalf of owners or 
tenants.

6151 Electric Includes office electric expenses.

6152 Gas (Utilities) Includes office gas expenses.

6153 Internet/Cable Includes office internet or cable expenses.

6154 Phone Includes office phone (including landline, mobile, and/or fax) expenses.

6155 Sewer Includes office sewer expenses.

6156 Trash Includes office trash service expenses.

6157 Water Includes office water expenses.

6159 Utilities - Other Includes Utilities expenses not otherwise categorized.

6199 Facilities - Other
Includes Facilities expenses that are not otherwise categorized. NOTE: Up 
to 99 additional decimal subaccounts may be added under this account.
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6200 New Owner Advertising
SECTION OVERVIEW: Includes only advertising expenses for acquiring 
new management contracts.

Does not include any advertising expenses 
related to Brokerage or Maintenance 
departments. These may be separated 
out into the Direct Brokerage or Direct 
Maintenance expense sections below. 
Also, does not include any vacancy 
advertising expenses (which should be 
booked in the Vacancy Advertising section 
below (6620s)).

6210 Internet Lead 
Generation

Includes internet advertising expenses for new owner lead generation. It 
is recommended that you create subaccounts for tracking expenses from 
each internet lead source individually (e.g. “6210.01 Google Adwords”).

6220 Non-Internet 
Lead Generation

Includes trackable non-internet advertising expenses for owner lead 
generation. “Trackable” refers to advertising expenses which generate new 
owner leads that may be tracked back to the corresponding advertising 
expense. For example, a postcard mailer with a trackable promo code 
should be considered a trackable “Non-Internet Lead Generation” expense. 
It is recommended that you create subaccounts for tracking expenses 
from each non-internet lead source individually (e.g. “6220.01 Postcard 
Campaign”).

6230 Referral Fees 
Expense

Includes any referral fees or revenue share paid to passive referral sources 
for acquiring new management contracts. Passive referral sources include 
individuals or companies which do not provide any ongoing management 
services for the property(s) being referred.

Does not include any referral fees or 
revenue share paid to referral sources who 
provide ongoing management services 
for the property(s) being referred. Such 
fees should be booked in the Direct Labor 
(6300s) section below.

6240 Website Includes all website hosting, development, and SEO expenses.

6299
New Owner 
Advertising - 
Other

Includes New Owner Advertising expenses that are not otherwise 
categorized. NOTE: Up to 99 additional decimal subaccounts may be added 
under this account.

6300 Direct Labor

SECTION OVERVIEW: Includes all property management-related direct 
labor expenses. NOTE: Direct Labor includes any employee or contractor 
who spends 50% or more of their time providing owner or tenant-facing 
value. This includes (but is not limited to) office admin and accounting staff, 
leasing agents, maintenance coordinators, property managers, inspectors 
and virtual assistants.

Does not include any expenses related 
to the Brokerage or Maintenance 
departments. These may be separated 
out into the Direct Brokerage or Direct 
Maintenance expense sections below.

6310 Direct Labor 
Wages

Parent account for all Direct Labor W-2 wages.
Does not include any contractor labor 
expenses.
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6311
Admin & 
Accounting 
Wages

Includes admin and accounting wages.

6312 Leasing Wages Includes leasing agent wages.

6313
Maintenance 
Coordination 
Wages

Includes maintenance coordinator wages.

6314
Property 
Management 
Wages

Includes property manager wages.

6315 Commercial PM 
Wages

Includes commercial property management wages.

6316 CA PM Wages Includes community association property management wages.

6317 Short-Term PM 
Wages

Includes short-term property management wages.

6319 Direct Labor 
Wages - Other

Includes Direct Labor Wages that are not otherwise categorized. NOTE: Up 
to 99 additional decimal subaccounts may be added under this account.

6320 Direct Labor 
Contractors

Parent account for Direct Labor Contractors expenses. Does not include any W2 wages.

6321
Admin & 
Accounting 
Contractors

Includes admin and accounting contractor expenses.

6322 Call Center 
Services

Includes call center service expenses.

6323 Inspection 
Contractors

Includes inspection contractor expenses.

6324 Leasing 
Contractors

Includes leasing agent contractor expenses.

6325
Maintenance 
Coordination 
Contractors

Includes maintenance coordinator contractor expenses.

6326
Property 
Management 
Contractors

Includes property management contractor expenses.
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6327 Commercial PM 
Contractors

Includes commercial property management contractor expenses.

6328 CA PM 
Contractors

Includes community association property management contractor 
expenses.

6331 Short-Term PM 
Contractors

Includes short-term property management wages.

6339
Direct Labor 
Contractors - 
Other

Includes Direct Labor Contractors expenses that are not otherwise 
categorized. NOTE: Up to 99 additional decimal subaccounts may be added 
under this account.

6400 Management Labor

SECTION OVERVIEW: Includes all management labor expenses. NOTE: 
Management Labor includes any employee or contractor who DOES NOT 
spend 50% or more of their time providing owner or tenant-facing value. 
This includes (but is not limited to) owners, a director of operations, a 
director of HR, and any sales and marketing staff.

6410 Owner 1 Wages Includes wages paid to the primary owner.

6420 Owner 2 Wages
Includes wages paid to the secondary owner. If there are more than two 
owners active in the business, please add a decimal subaccount under 
6440 - Other Management Wages (e.g. 6440.01 - Owner 3 Wages).

6430 PM Sales & 
Marketing Labor

Parent account for property management sales and marketing labor.

6431 PM Sales Wages Includes property management sales wages.

6432 PM Sales 
Contractors

Includes property management sales contractor expenses.

6433 PM Marketing 
Wages

Includes property management marketing wages.

6434 PM Marketing 
Contractors

Includes property management marketing contractor expenses.

6440
Other 
Management 
Wages

Includes wages paid to management staff who are neither owners nor sales 
and marketing staff.

6450
Other 
Management 
Contractors

Includes expenses for management contractors who are not sales and 
marketing contractors.
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6500 Payroll Tax & Benefits
SECTION OVERVIEW: Includes all payroll taxes and benefits expenses for 
property management employees.

Does not include payroll taxes and 
benefits expenses for the Maintenance or 
Brokerage departments.

6510 Employee Gifts Includes employee gift expenses.

6520 Employee 
Insurance

Parent account for Employee Insurance expenses. All PM-related employee 
insurance expenses may be booked to this account if additional breakout 
is not desired. In other words, use of the subaccounts below is not required 
(with the exception of any non-deductible insurance expenses which must 
be broken out).

6521 Dental Insurance Includes the employer portion of dental insurance expenses.

6522 Group Term Life 
Insurance

Includes the employer portion of group term life insurance expenses.

6523 Health Insurance Includes the employer portion of health insurance expenses.

6524 Owner’s Life 
Insurance

Includes owner’s life insurance expenses. NOTE: these expenses are non-
deductible.

6525 S-Corp Owners’ 
Health Insurance

Includes S-Corp owners’ health insurance expenses.

6526
Short-Term 
Disability 
Insurance

Includes short-term disability insurance expenses.

6527 Workers’ Comp 
Insurance

Includes workers’ compensation insurance expenses.

6529 Employee 
Insurance - Other

Includes the employer portion of Employee Insurance expenses that are not 
otherwise categorized (e.g. Vision Insurance).

6530 Payroll Taxes
Includes the employer portion of payroll tax expenses. All PM-related payroll 
tax expenses may be booked to this account if additional breakout is not 
desired. In other words, use of the subaccounts below is not required.

6531 Federal Payroll 
Taxes

Includes the employer portion of federal payroll tax expenses.

6532 SUI Includes the employer portion of state unemployment insurance expenses.

6539 Employer Taxes - 
Other

Includes employer Payroll Taxes expenses that are not otherwise 
categorized. NOTE: Up to 99 additional decimal subaccounts may be added 
under this account.
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6540 Retirement Includes the employer portion of retirement expenses (e.g. 401(k) expense).

6599 Payroll Tax & 
Benefits - Other

Includes Payroll Taxes & Benefits expenses that are not otherwise 
categorized. NOTE: Up to 99 additional decimal subaccounts may be added 
under this account.

6600 Other Operating Expense
SECTION OVERVIEW: Includes all other property management-related 
operating expenses.

Does not include any brokerage or 
maintenance-related other operating 
expenses. Direct Maintenance or direct 
Brokerage expenses may be booked to the 
Direct Maintenance Expense (6700s) or 
Direct Brokerage Expense 6800s) sections 
below.

6610 Direct PM 
Expense

Parent account for Direct Property Management Expense. Direct expenses 
are expenses incurred that vary with changes in the volume of services 
provided.

6611 Application Fees 
Expense

Includes application handling expenses.

6612 Evictions/PM 
Legal Expense

Includes evictions and property management legal expenses.

6613 Lockboxes/Self-
Showing Services

Includes lockboxes and self-showing services expenses.

6614 Owner & Tenant 
Concessions

Includes owner and tenant concession expenses.

6615 Postage & 
Shipping

Includes postage and shipping expenses.

6616
Tenant/Renter 
Insurance 
Expense

Includes tenant/renters insurance expenses.

6617 Other Owner 
Direct Expense

Includes other owner direct expenses.

6618 Other Tenant 
Direct Expense

Includes other tenant direct expenses.

6619 Direct PM 
Expense - Other

Includes Direct PM Expenses that are not otherwise categorized. NOTE: Up 
to 99 additional decimal subaccounts may be added under this account.

6620 Vacancy 
Advertising

Parent account for Vacancy Advertising expenses.
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6621 Photography
Includes property management photography expenses for units under 
management.

Does not include photography expenses 
for brokerage listings.

6622 Signage
Includes property management signage expenses for units under 
management.

Does not include signage expenses for 
brokerage listings.

6623 Vacancy Listings 
Expense

Includes vacancy listing expenses for units under management.
Does not include expenses for brokerage 
listings.

6629
Vacancy 
Advertising - 
Other

Includes Vacancy Advertising expenses that are not otherwise categorized. 
NOTE: Up to 99 additional decimal subaccounts may be added under this 
account.

6631 Bad Debt
Includes bad debt expenses. Bad debt expenses refer to the loss that 
a company experiences when it provided services but failed to receive 
payment for services billed.

6632 Bank Service 
Charges

Includes bank service charges expenses.

6633 Charitable 
Donations

Includes charitable donation expenses.

6634 Education & 
Training

Includes education and training expenses.

6635 Employee 
Recruiting

Includes employee recruiting expenses.

6636 Fines & Penalties Includes fines and penalties expenses.

6640 Insurance Parent account for Insurance expenses.

6641 Auto Insurance Includes auto insurance expenses.

6642
Directors 
& Officers 
Insurance

Includes directors and officers insurance expenses.

6643 E&O Insurance Includes errors and omissions insurance expenses.

6644 General Liability 
Insurance

Includes general liability insurance expenses.

6645 Property/Renters 
Insurance

Includes property/renters insurance expenses. Typically, this is for 
insurance expenses related to a company’s office space.

Does not include insurance expenses 
incurred for tenants under management

6649 Insurance - Other
Includes Insurance expenses that are not otherwise categorized. NOTE: Up 
to 99 additional decimal subaccounts may be added under this account.
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6650 Meals & 
Entertainment

Parent account for Meals and Entertainment expenses.

6651
Meals & 
Entertainment 
(100%)

Includes meal and entertainment expenses which are 100% deductible.

6652
Meals & 
Entertainment 
(50%)

Includes meal and entertainment expenses which are 50% deductible.

6653
Meals & 
Entertainment 
(0%)

Includes meal and entertainment expenses which are 0% deductible.

6654 Licenses & 
Permits

Includes licenses and permits expenses.

6655 Merchant Service 
Fees

Includes merchant service fees expenses.

6656 Office Supplies & 
Expenses

Includes office supply expenses.

6657 Payroll 
Processing Fees

Includes payroll processing fees expenses.

6658 Professional 
Dues

Includes professional dues expenses.

6660 Professional Fees 
& Services

Parent account for Professional Fees & Services expenses.

6661 Accounting Includes year-end or one-time accounting expenses.
Does not include routine accounting or 
bookkeeping expenses.

6662 Broker Fees Includes fees paid to a broker of record.

6663 Coaching/
Consulting

Includes coaching and consulting expenses.

6664 IT Services Includes IT services expenses.

6665 Legal Includes legal expenses.
Does not include evictions or other 
property management legal expenses.

6669
Professional 
Fees & Services 
- Other

Includes Professional Fees & Services expenses that are not otherwise 
categorized. NOTE: Up to 99 additional decimal subaccounts may be added 
under this account.
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6670 Taxes Parent account for Tax expenses.
Does not include federal or state income 
tax.

6671 Property Taxes Includes property tax expenses.

6672 State & Local 
Taxes

Includes state and local operating taxes. Does not include state income tax.

6679 Taxes - Other
Includes Tax expenses that are not otherwise categorized. NOTE: Up to 99 
additional decimal subaccounts may be added under this account.

6680 Travel Parent account for Travel expenses.

Does not include any non-operating travel 
expenses. Deductible non-operating 
expenses may be booked to 8999 - Other 
Expenses - Other

6681 Lodging Includes lodging expenses.

6682 Parking & Tolls Includes parking and tolls expenses.

6683 Transportation Includes travel-related transportation expenses.

6689 Travel - Other
Includes Travel expenses that are not otherwise categorized. NOTE: Up to 
99 additional decimal subaccounts may be added under this account.

6691 Reconciliation 
Discrepancies

Includes reconciliation discrepancies.

6692 Royalty & 
Franchise Fees

Includes royalty and franchise fees expenses.

6693 Uncategorized 
Expense

Includes uncategorized expenses

6699 Other Operating 
Expense - Other

Includes Other Operating expenses that are not otherwise categorized. 
NOTE: Up to 99 additional decimal subaccounts may be added under this 
account.

6700 Direct Maintenance Expense
SECTION OVERVIEW: Includes all maintenance expenses which may be 
separated into the accounts below.

6710 Maintenance Auto Parent account for Maintenance Auto expenses.

6711 Maintenance 
Auto Lease

Includes auto lease expenses related to the residential Maintenance 
department.

6712
Maintenance 
Auto Repairs & 
Maintenance

Includes auto maintenance and repair expenses related to the residential 
Maintenance department.
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6713
Maintenance 
Gas & Mileage 
Reimbursement

Includes gas and mileage reimbursement expenses related to the 
residential Maintenance department.

6714 Maintenance 
Parking & Tolls

Includes parking and tolls expenses related to the residential Maintenance 
department.

6719 Maintenance 
Auto - Other

Includes Maintenance Auto expenses that are not otherwise categorized. 
NOTE: Up to 99 additional decimal subaccounts may be added under this 
account.

6720
Maintenance 
Bonding & 
Insurance

Includes bonding and insurance expenses related to the residential 
Maintenance department.

6730
Maintenance 
Equipment 
Rental/Lease

Includes equipment rental/lease expenses related to the residential 
Maintenance department.

6740
Maintenance 
Licenses & 
Permits

Includes licenses and permits expenses related to the residential 
Maintenance department.

6750
Maintenance 
Payroll Tax & 
Benefits

SECTION OVERVIEW: Includes all payroll taxes and benefits expenses for 
maintenance employees.

6751 Maintenance 
Employee Gifts

Includes maintenance employee gift expenses.

6752
Maintenance 
Employee 
Insurance

Includes all maintenance employee insurance expenses. NOTE: Up to 99 
additional decimal subaccounts may be added under this account.

6753 Maintenance 
Payroll Taxes

Includes the employer portion of payroll tax expenses for all maintenance 
employees. NOTE: Up to 99 additional decimal subaccounts may be added 
under this account.

6754 Maintenance 
Retirement

Includes the employer portion of retirement expenses for all maintenance 
employees (e.g. 401(k) expense).

6759
Maintenance 
Payroll Tax & 
Benefits - Other

Includes Maintenance Payroll Taxes & Benefits expenses that are not 
otherwise categorized. NOTE: Up to 99 additional decimal subaccounts 
may be added under this account.

6760 Maintenance 
Wages

Includes maintenance wages.
Does not include maintenance coordination 
wages.
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6770
Maintenance 
Tools & 
Equipment

Includes tools and equipment expenses related to the residential 
Maintenance department

6799
Direct 
Maintenance 
Expense - Other

Includes Direct Maintenance expenses that are not otherwise categorized. 
NOTE: Up to 99 additional decimal subaccounts may be added under this 
account.

6800 Direct Brokerage Expense
SECTION OVERVIEW: Includes all brokerage expenses which may be 
separated into the accounts below.

6810 Brokerage 
Advertising

Parent account for Brokerage Advertising expenses.

6811
Brokerage 
Internet Lead 
Gen

Includes internet advertising expenses for brokerage lead generation. It 
is recommended that you create subaccounts for tracking expenses from 
each internet lead source individually (e.g. “6811.01 Google Adwords”).

6812
Brokerage Non-
Internet Lead 
Gen

Includes trackable non-internet advertising expenses for brokerage lead 
generation. “Trackable” refers to advertising expenses which generate new 
brokerage leads that may be tracked back to the corresponding advertising 
expense. For example, a postcard mailer with a trackable promo code 
should be considered a trackable “Non-Internet Lead Generation” expense. 
It is recommended that you create subaccounts for tracking expenses 
from each non-internet lead source individually (e.g. “6812.01 Postcard 
Campaign”).

6813
Brokerage 
Referral Fees 
Expense

Includes referral fees expenses related to the Brokerage department.

6814 Brokerage 
Website

Includes all website hosting, development, and SEO expenses related to 
the Brokerage department.

6819
Brokerage 
Advertising - 
Other

Includes Brokerage Advertising expenses that are not otherwise 
categorized. NOTE: Up to 99 additional decimal subaccounts may be added 
under this account.

6820 Brokerage Dues Includes brokerage dues expenses.

6830
Brokerage 
Education & 
Training

Includes brokerage education and training expenses.

6840 Brokerage Listing 
Advertising

Parent account for Brokerage Listing Advertising expenses.

6841 Brokerage 
Listings

Includes brokerage listings expenses.
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6842 Brokerage 
Photography

Includes brokerage photography expenses.

6843 Brokerage 
Signage

Includes brokerage signage expenses.

6849
Brokerage Listing 
Advertising - 
Other

Includes Brokerage Listing Advertising expenses that are not otherwise 
categorized. NOTE: Up to 99 additional decimal subaccounts may be added 
under this account.

6850 Brokerage Payroll 
Tax & Benefits

SECTION OVERVIEW: Includes all payroll taxes and benefits expenses for 
brokerage employees.

6851 Brokerage 
Employee Gifts

Includes brokerage employee gift expenses.

6852
Brokerage 
Employee 
Insurance

Includes all brokerage employee insurance expenses. NOTE: Up to 99 
additional decimal subaccounts may be added under this account.

6853 Brokerage Payroll 
Taxes

Includes the employer portion of payroll tax expenses for all brokerage 
employees. NOTE: Up to 99 additional decimal subaccounts may be added 
under this account.

6854 Brokerage 
Retirement

Includes the employer portion of retirement expenses for all brokerage 
employees (e.g. 401(k) expense).

6859
Brokerage Payroll 
Tax & Benefits - 
Other

Includes Brokerage Payroll Taxes & Benefits expenses that are not 
otherwise categorized. NOTE: Up to 99 additional decimal subaccounts 
may be added under this account.

6860
Brokerage 
Professional Fees 
& Services

Includes brokerage professional fees and services expenses.

6870 Brokerage Wages Includes brokerage wages expenses.

6899 Direct Brokerage 
Expense - Other

Includes Direct Brokerage expenses that are not otherwise categorized. 
NOTE: Up to 99 additional decimal subaccounts may be added under this 
account.

7000 OTHER INCOME SECTION OVERVIEW: Includes all non-operating income.

7100 Consulting 
Income

Includes income from property management consulting services.

7200 Interest Income Includes interest income.
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7999 Other Income - 
Other

Includes Other Income that is not otherwise categorized. NOTE: Up to 99 
additional decimal subaccounts may be added under this account.

8000 OTHER EXPENSES SECTION OVERVIEW: Includes all non-operating expenses.

8100 Amortization Includes amortization expenses.

8200 Depreciation Includes depreciation expenses.

8300 Income Taxes Includes federal and state income taxes.

8400 Interest Expense Includes interest expense.

8999 Other Expenses 
- Other

Includes Other Expenses that are not otherwise categorized. This is where 
it is recommended to book deductible non-operating expenses. You should 
consult your tax counsel to confirm that any non-operating expenses are 
in fact deductible. NOTE: Up to 99 additional decimal subaccounts may be 
added under this account.
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